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News and Announcements 

• APPLE5HARE SITE LICENSE 

We recently obtained a site license for the AppleShare File Server 
software that runs on Macintoshes. If you have already purchased 
the Mac AppleShare server software, be sure to read the AppleShare 
Upgrades section below. 

This site license covers the AppleShare Server software (which runs 
on dedicated Macs that act as a file server for other machines on a 
network). To share access to an AppleShare file server, Macs and 
IBM-type microcomputers must run the clientportion of the 
AppleShare software. AppleS hare client software is included with 
recent releases of the Macintosh system software. IBM-compat
ible client software may be purchased separately. 

University departments (but not individual faculty, staff, or stu
dents) can lease the Macintosh AppleShare File Server software, by 
paying an initial $75 fee. The initial fee includes the cost of using 
one copy of the server software for the first year. Departments 
that want to continue their licenses after the first year must pay an 
annual fee; currently that fee is $50. (Previously the Electronics 
Desk sold AppleShare File Server software for Macs for $425.) 

Obtaining the Site License 
Before we will release the software, we need a Journal Voucher 
and the signature of an authorized user on the AppleShare Regis
tered Authorized User Certificate. To obtain the software, bring a 
signed Journal Voucher crediting the ACSS budget number 0950-
1604-07 to room 118 in the Shepherd Labs building. 

If departments decide not to renew their license, they must 
destroy all copies of the AppleS hare File Server software and 
return their original disks to us. 

AppleShare Upgrades 
The initial and annual renewal fees that departments pay to partici
pate in a site license entitles them to free updates. 

If your department has already purchased the file server software, 
you too, are partially covered by this site license; you're covered 
for free upgrades through June 30, 1989. This means you can get 
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Review: Microsoft Word 
version 4.0 for IBM 

0 Microsoft Word for IBM-compatible personal 
co.mputers has several features that make it well 
SUited for many users. First of all, Word supports 

several brands of mice. Anyone who is uncomfortable 
using a keyboard or who is already comfortable using a 
mouse may welcome software that lets them use a mouse. 
Second, there are many similarities between the Mac and 
DOS versions ofWord; for example, the speed formatting 
commands are the same. In addition, both versions use 
the Character and Paragraph menus and a global menu 
that the Mac version calls Section and the DOS version calls 
Division for formatting documents. These similarities can 
be important to anyone who must switch between a 
Macintosh and a DOS computer for word processing. 

This review is for current Word users who want to know a 
little about 4.0's changes and for those who are consider
ing buying Word. The review is written primarily for the 
keyboard user. Although we consider using a mouse for 
editing Word documents to be superior to using the 
keyboard, many people do not own a mouse· therefore we 
will only briefly describe using a mouse. ' ' 

HARDWARE REQUIREMENTS 

Word 4.0 requires a minimum of 256K of RAM DOS 
version 2.0 or later, and two floppy disk drives; however, 
we recommend a hard drive. To use the Help Tutorial you 
must have at least 320K of RAM. 

TEXT AND GRAPHICS DISPLAY MODES 

If you have a graphics display adapter, Word can be seen in 
Graphics or Text (character) Mode. The graphics capabili
ties of your configuration will determine the resolution of 
the screen display. The Hercules-compatible and VGA 

adapter configurations look better in the Graphics Mode 
than the CGA adapters (which have lower resolution). 
(F?r more information on graphics adapters, read the Video 
Dtsplay Adapters section of the IBM and Zenith Micro
computers handout that is available in the Microcomputer 
HelpLine.) In the Graphics Mode the screen display is 
similar to the way it will be printed; bold, italics, and 
underlining are displayed on the screen. 

Although the Text Mode runs faster than the Graphics 
Mode, it does not display as much information. For 
example, you cannot see italics on the screen. With a color 
monitor, bold formatted text is displayed in a more intense 
color and other text formats appear in a color other than 
the background color. With a monochrome monitor bold 
text is displayed more intensely and other text forma~ 
such as italics, appear as underlined text. ' 

You can start Word by typing the start-up command of 
WORD plus an option, such as I G to start in the Graphics 
Mode or /C to start in the Text (character) Mode. The 
mode that is selected when you quit Word will be saved in 
the file called MW. IN I. Since this file sets the mode for the 
next time you use Word, you really only need to determine 
what mode you prefer once. 

BASIC FEATURES 

All the ~asic features that you would expect in any word 
processmg package are available in Word. You can insert 
and delete text within a document or copy text between 
?o~uments. ~haracters can be formatted using bold, 
Itahcs, underlme, superscript, and subscript. You can 
format paragraphs and documents using full right and left 
margin ~usti~cation or using a ragged right margin (as you 
can seem this newsletter); you can center lines or para
graphs between the left and right margins. Larger pieces 
of the document can be formatted by sections. You can 
search ~or text, replace it once you've found it, look up 
words m the Thesaurus, and check your document for 
proper spelling. 

Figure 1: Word Screen With Menus Word uses a menu at the 
bottom of the screen that 
shows you the commands 
that are available to you. 

The text of your Word document appears here. The menus 
are at the bottom of the screen .... 

~===============================================SAMPLE.DOC~ 

COMMAND: Copy Delete Format Gallery Help Insert Jump Library 
Options Print Quit Replace Search Transfer Undo Window 

Edit document or press Esc to use menu 
Pgl Lil Col {} ? Microsoft Word 

The menus can be visible at 
all times or can be turned 
off. Figure l shows a con
densed Word screen with its 
main menu commands at the 
bottom. 

Accessing menus in version 
4.0 is easier than it was in 
version 3.0. To use the 
keyboard to access version 
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4.0's menus, such as Copy and Transfer, press the (Esc I key. 
To go back to editing your document, press the (Esc! key 
again. Each menu presents you with a new menu of 
options. Word calls these options fields. 

ODD FEATURES 

Word uses the command Transfer to mean move, retrieve, 
or open a document. Although most ofWord's menus let 
you use the (Esc I key to return to the document screen, 
some menus only let you return to the document screen by 
selecting an Exit option. 

NEW VERSION 4.0 FEATURES 

The most obvious difference between versions 3.0 and 4.0 
is the improved response time, particularly in cursor 
movement and scrolling. (See our September, 1986 
newsletter for a review ofWord version 3.0.) 

The Library Document Summary sheet is a new feature. 
The Summary sheet provides entry fields for the docu
ment's title, author, operator (typist), keywords, com
ments, and creation and revision dates; the dates can 
automatically use the computer's system date. You can use 
the information in the Keywords and Comments fields when 
searching for a document. 

You can modify version 4's screen appearance in several 
ways. One option lets you remove the screen's borders. 
By not using the border you see in Figure l, you have 
space for two more lines and two more columns of text. 
If you use a mouse, you will not want to use this option 
because some mouse speed features will not be available. 

A welcome addition to version 4.0 is the inclusion of line 
drawing capabilities. As usual, printed results depend on 
the capabilities of the printer you are using. You can draw 
lines in your document in several ways. For example, you 
can tell Word to draw a box around a paragraph or insert a 
line under a paragraph. Word also lets you insert vertical 
line tabs. Figure 2 shows these three types of lines. The 
box was drawn around the title using the Format menu's 
Border/Box command; and the horiwntal underline was 
drawn using the Format menu's Border/Line command. 
We created the table using 
vertical tab settings to draw the 

print it, you can preview your document on the screen. 
This feature is useful for checking formatting on complex 
documents. Once Printer Display is selected, the screen 
shows how the characters, spaces, and tabs will appear in 
relation to each other when printed. One drawback to this 
feature is that whether you use the Text or Graphics Mode, 
the screen displays text in a fixed-width. Since you cannot 
see smaller or larger text, or proportional-width fonts, text 
will not appear on the screen quite the way it is printed. 
For example, if you format a document with a small sized 
font, the lines will scroll off the screen. (The lines scroll off 
the screen because, when printed, the document will have 
more words per line than can be seen on the screen.) 

SPELLER AND THESAURUS 

Version 4.0 has a larger 130,000 word dictionary. You can 
use the Library menu's Speller feature to check the spelling 
of a whole document or selected portions of a document. 
In addition, you can build and edit your own specialized 
dictionary. 

Word also includes a 220,000 word Thesaurus. To access 
the Thesaurus, select a word and then press the @ED and 
ffi keys. Once you do this, you will see a list of synonyms 
on the screen. After positioning the cursor on the syno
nym you prefer, press the (Enter! key and the new word will 
replace the original word in the document. 

UsiNG WoRD 

Word is word processing software that treats text as a 
document or a collection of text. An efficient way to use 
Word is to concentrate on getting your thoughts or the 
text keyed into the computer. Then, after the document 
has been entered, format it through the Format menu's 
Character, Paragraph, or Division menus. (These are the 
units of text that Word manages.) The following steps 
refer to using Word from the keyboard. 

After starting Word, begin creating a new document by 
pressing the (Esc I key and typing "t" to select the Transfer 
menu, then typing" 1" to select the Load command. Now 
type in whatever name you want your new file to have. 
Word will ask if you want to create a new file; respond by 

pressing "y" for Yes. Once 

lines between the columns. Figure 2: Word Line Drawing Sample 

you've done this, a blank 
document is displayed on 

You can also use a manual 
drawing mode. In this mode 
you use your keyboard's arrow 
keys to draw horiwntal and Wind 
vertical lines in whatever 
lengths you want. 
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your screen. 

As you type, you can use 
Word's speed formatting 
commands to change text to 
bold, italic, or underlined 
formats. For example, to 
italicize words as you enter 
text, press and hold down the 
~ key then press the CD 



key. Press the @!) key and the I Spacebar I to return to un
italicized text. 

After entering the text, you can format the entire docu
ment by using the Format menu's Di11ision command to 
set features such as margins, page-numbering format, and 
Running Header. 

Paragraph attributes can be set using the Format menu's 
Paragraph command. These attributes include spacing 
between lines, paragraph alignment (such as left and right 
justified or ragged right), and first line indentations of mar
gins. To select the entire document for formatting, press 
the (Shift) key then the (F10) key. You can also select por
tions of the document. For example, to select a paragraph, 
use the arrow keys to place the cursor anywhere within the 
paragraph you want to format and press the ffi key. (If 
you have a mouse, you can move the cursor to the para
graph and click both mouse buttons.) 

Font selection can be done for the whole document or for 
portions of the document. Here is a sample font format
ting session. Highlight the entire document by pressing 
the (Shift) key then the (F10) key. Then press the (Esc) key 
and select the Format menu followed by the Character 
menu. Once in the Character menu you can change the 
font. Use the (Tab I or arrow keys to select the Font Name 
field and press them key to see the fonts available for the 
printer you have chosen. Press the (Enter) key after posi
tioning the cursor on the font name you want to use. 

CREATING HEADERS AND FOOTERS 

The header or footer text must be the first lines of your 
document. To create either a header or footer, use the 
Format menu's Running Head option. Choose either Top 
or Bottom in the Running Head menu's Position field. You 
can set the Running Head to print on odd or even pages or 
optionally on the first page. Any of the text formatting 
commands can be used in the Running Head, such as bold 
and small caps. 

Once you have chosen Running Head, the text is marked 
with a caret (") indicating that it is the Running Head. 
You can see this caret in Figure 3. You can also see that 
the word "Introduction" is not at the left edge; Word 
treats margins differently in the Running Head than it 
treats margins in the body of the document. 

the body of the document is displayed flush with the left 
margin of your screen. 

Figure 3 shows the Running Head "Introduction to 
Microsoft Word" with the document text below it. Look
ing at Figure 3 you may initially assume the heading's left 
margin and the text's left margin won't be the same. 
However, when this page is printed, the four lines you see 
in Figure 3 will have the same left margin. Despite what 
you see on the screen, the four lines will be printed 1.25 
inches from the left edge of the paper. 

One final caution, the Running Head's margins must be 
set independently from the margins of the document. 

USING ADVANCED FEATURES 

Some ofWord's more complex features include the ability 
to change spacing between lines, style sheets of formatting 
commands, outlining, and generating a table of contents. 
We'll discuss three advanced features below: glossaries, 
footnotes, and hidden text, which you use to import 
spreadsheets and place graphics. 

Glossary 
The Glossary function lets you store blocks of text that you 
use repeatedly. Retrieving the text is quick; type in the 
code or name that you have assigned to the text and press 
them key. You might use the Glossary to store and 
quickly insert a return address or difficult text combina
tions. You can also use Word's Glossary to quickly insert 
often-used command sequences, such as a sequence of 
commands to simultaneously make text bold and italic and 
center the paragraph in which that text appears. 

Footnotes 
The Format menu includes Footnote and Endnote options. 
To add footnotes to your document, select the spot where 
you want the the footnote reference to be inserted. Then 
select the Footnote option from the Format menu. You can 
move or delete footnotes like any other text. Footnotes 
can be printed on the same page or at the end of the 
document. Word will automatically number the footnotes; 
or if you do not want consecutive numbers, you can enter 
your own reference mark. If you're using a lot of foot
notes, you can set up two windows on your screen. Your 
document will be in one window; associated footnotes will 
be displayed in the other window. 

Figure 3: Running Head and Text 
When you are first learning Word, this 
difference can be confusing. The 
Running Head's left margin is displayed 
on your screen as it will be indented from 
the left edge of the paper. However, the 
left margin for the body of the document 
is not displayed as it will be indented 
from the left edge of the paper. Instead, 

A Introduction to Microsoft Word 

Word contains powerful, built-in word processing features 
that can handle the routine parts of your work, enabling 
you to easily increase your productivity. 
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Note that when you use the I Shift I key and the I F10 I key to 
select the entire document (as we recommended earlier) 
and set the font attributes, the footnotes are not selected. 
Just as the Running Header's margins are set separately, 
the footnote font style is set separately. To select the font 
style for footnotes, move the cursor into the footnote 
window and press the !shift) and the IFtO) keys. These 
keystrokes select the footnotes as a group. Use the Format 
menu's Character command to select font attributes. 

Hidden Text 
Comments or coded entries can be entered into a Word 
document as Hidden Text. 

Using Word's Hidden Text feature to include Lotus, 
Excel, and Multiplan spreadsheets in a Word document is 
easy. The Hidden Text you enter into the Word docu
ment includes the name of the file that is to be imported 
into the Word document. If you later update the spread
sheet file you want to import, you must re-link it to the 
Word document. If you don't re-link the file, the changes 
will not be reflected in your Word document. 

Although you cannot see graphics embedded in a Word 
document on your screen, graphics can be included during 
printing. To do this, enter a code as Hidden Text to link 
the graphics to the document. The kinds of graphics that 
you can include are Print Files, such as those that are 
created by Microsoft Chart's Print/File command. When 
Word encounters the code (entered as Hidden Text), it 
stops printing and sends the graphics file to the printer. 

We found linking graphics to be frustrating and more 
difficult than linking Lotus files; the instructions on how to 
use this feature are minimal. 

PRINTING 

As with all software, printer output depends on how well 
the printer and the software communicate. For example, 
using the EPSONLX.PRD driver and printing on the 
Epson LX 800 printer, Word will give you output in Elite, 
Eli te-D (double strike), NLQ (near letter quality), Pica, 
and Pica-Din sizes ranging from Elite point size 7 (16 
pitch) to Pica 16 (7.5 pitch). (Note that Word's font size 
and measurements are given in point sizes.) Bold, italic, 
underline, microspace justification, superscript and sub
script, small caps, and strikethrough are some of the 
printing options Word gives you on the LX 800 printer. 

PostScript printer support has been added to Word version 
4.0. You get drivers for portrait and landscape modes for 
the Apple LaserWriter Plus and liNT and their eleven 
built-in fonts. 

Drivers for some printers that were not included with the 
software are available on Supplemental Printer Disks from 

Microsoft, such as drivers for the Hewlett-Packard Desk]et. 
(Desk]et users can also copy the new driver for their 
printer by bringing a diskette to the Micro HelpLine.) 

Hewlett-Packard Laser]et owners may be interested in the 
Z cartridge. This cartridge has the Helvetica and Times 
Roman fonts and was developed especially for the Laser]et 
Series II and Microsoft Word. The printer driver 
HPLASER3.PRD gives you these fonts as well as the 
Laser]et's internal Courier font. In all, this cartridge gives 
you a good range of character formats for business and 
classroom document processing. Also included in 
HPLASER3.PRD are printer drivers for HP's] and R 
cartridges. This means that this one driver can be used for 
a Laser]et that has any two of these cartridges (Z, ], orR) 
installed in the printer. Word groups other combinations 
ofLaser]et cartridges; another good combination is the 
HPLASERI.PRD driver which supports HP cartridges A, 
B, C, D, E, G, H, ], L, Q, W, and X. 

DOCUMENTATION AND TUTORIALS 

The Book Center stocks the Academic Edition of Word 
4.0; it is identical to the Standard Edition except for 
documentation. Currently three manuals are packaged 
with the Academic Edition: Printer Information, Using 
Microsoft Word, and the Pocket Guide. You also get a 
template that includes the speed formatting key combina
tions, the function key commands, keyboard actions, and 
number pad options. You can place this template along 
the top of your keyboard. Previous versions of Word had a 
smaller template that only fit over the function keys. 

The Printer Information manual covers problems and basic 
printing concepts; it also includes information on the 
printers Word supports, such as which fonts and formatting 
options are supported. Before deciding which printer to 
purchase, you may want to look at the printer manual. 
You can use this manual to help you determine what 
printer will give you the Word output you want. The bad 
news about printer manuals, and software that supports 
printers, is that they are usually a step or two behind the 
printers that are released. This means the model you are 
interested in may not be listed in Word's printer manual. 

Using Microsoft Word is the main manual; it includes infor
mation on setting up and starting Word. The manual is 
easy to follow and its index is quite thorough. The index 
helps make Word's documentation easier to use than many 
software manuals. The Pocket Guide is a small paperback 
loaded with information, such as a condensed guide on key 
usage, and quick references on using mice, rulers and tabs, 
and screen symbols. 

Unfortunately, Word's Reference manual is currently not 
packaged with the Academic Edition. Fortunately, you can 
purchase other Word manuals separately (see the And 



Books, Too column in this newsletter). The Academic 
Edition includes a card called Additional Documentation 
Order Form. To get Word's Reference manual, fill in and 
mail this card to Microsoft Campus Education Offer; your 
cost is $25 plus $2.50 for shipping and handling. This 
manual contains concise material on the edit menu op
tions, a section on error messages and corrective actions a 
dictionary of terms, and appendixes. Without this or a ' 
similar Word manual, you'll be handicapped in learning 
how to fully utilize Word. 

Word includes three learning tutorials: Essentials for Key
board and Mouse, which is geared for the beginner, Ad
vanced Lessons for Keyboard, and Advanced Lessons for 
Mouse. The tutorials' menus are organized so that you can 
pick and choose the lessons you want to cover. Anyone 
who has gone through previous Word tutorials will 
recognize the format. 

SuMMARY 

If you have used Microsoft Word on the Macintosh the 
version for DOS computers has similarities which m'ake it 
easier to learn. The speed formatting key combinations are 
similar. The logic behind the style sheets, formatting of 
characters and paragraphs and division (sections) is similar. 
However, using Word on a DOS computer system could 
also be disillusioning to Macintosh users; the DOS version 
cannot do all that the Macintosh version can do. Limita
tions in the use of graphics and on-screen formatting can 
be frustrating. 

Word version 4.0 is flexible, powerful word processing 
software for IBM-compatible computers. You can enter 
Word commands in a variety of ways - from the keyboard 
using the menus at the bottom of the screen, by combina
tions of keystrokes, or by using a mouse. Word can be 
used as a simple word processor using a few of its many 
menu commands. Word can also be used for much more 
complex document processing by those who want to take 
the time to learn and understand the application. This 
versatility means Word may fit the needs and styles of a 
workgroup that includes speed typists, hunt-and-peck 
composers who only write a few memos a week, and for 
those who use both Macintosh and DOS computers. 

Version 4.0 ofWord was released in 1988. (Registered 
users of Word should have received a mailing with an offer 
to upgrade their software.) You can purchase the Aca
demic Edition of Word version 4.0 at the Electronics Desk 
in Williamson Hall for $82. (Currently you can special 
order the Standard Edition for $205.) Those who want to 
share Word documents on a local area network can pur
chase a network version ofWord at the Electronics Desk 
for $168. 

WordPerfect File Transfers: 
Mac~ IBM 

0 In our November 1988 newsletter we reviewed 
WordPerfect .1.0.1 for ~e Macintosh. In this 
follow-up article we reVIew transferring 

WordPerfect 1.0.1 documents to and from WordPerfect 
4.2 for IBM and compatible microcomputers and what 
happens to the original document after it's transferred. 
(Currently, you cannot directly transfer documents be
tween Macintosh WordPerfect 1.0.1 and IBM WordPerfect 
5.0; you indirectly transfer documents by having WordPer
fect 5.0 read or create WordPerfect 4.2 documents.) 

FILE TRANSFER SETUPS 

In order to transfer Mac WordPerfect version 1.0.1 docu
ments to and from IBM WordPerfect version 4.2, you 
need some additional hardware and software that will allow 
you to transfer documents stored on a Mac disk to an MS/ 
PC-DOS disk and vice versa. We transferred documents 
using two different file transfer programs: Apple File 
Exchange version 1.1 and MacLink Plus version 2.08. 

Apple File Exchange is a file transfer program included with 
Apple's system software. In order to use Apple File 
Exchange, you need a floppy drive capable of reading and 
writing to a DOS disk. For our tests we used Apple's PC 
5.25-inch floppy drive. (Apple's PC drive requires an 
interface card that is installed in an expansion slot· the 
drive can only be attached to a Mac SE or a Mac II.) This 
drive can read and write to DOS 5.25-inch 360Kdisks. 
(Note: Apple File Exchange also works with Apple's 
FDHD 3.5-inch drives which can read 720Kand 1.44MB 
DOS disks; however, the FDHD drives are currently 
available only on the Mac Ilx and the Mac SE/30.) 

MacLink Plus is a file transfer program by Data viz that 
works with several different hardware setups. We used 
MacLink Plus to transfer documents between a Mac SE 
and an IBM PC-AT; these machines were linked together 
with the serial cable that comes with MacLink Plus. (This 
cable has a Mac Plus/SE/II-style, 8-pin DIN connector 
on one end and an IBM-PC style, 25-pin connector on the 
other. Depending on what kind of equipment you have, 
you may also need other adapter cables.) 

TRANSFERRING DocUMENTS 

Hereafter as we discuss the two different versions of 
WordPerfect, we will refer to the Mac WordPerfect version 
1.0.1 as •WordPerfect, and the IBM WordPerfect version 
4.2 as WordPerfect 4.2. Transferring documents with 
either Apple File Exchange or MacLink Plus is relatively 
straightforward. 
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Once you have started up Apple File Exchange and have the 
contents of your Mac disk and DOS disk displayed, your 
screen will look something like Figure l. To select the 
Mac or DOS document you want to transfer, simply click 
on it once, as we did with the document called "second 
test." After a document has been selected, click on the 
Translate button. A dialog box will show you that the 
transfer is taking place and that default translation is being 
used; in other words, the document is being transferred as 
is, without any conversion. 

Using MacLink Plus is somewhat more complicated than 
using Apple File Exchange. First you set up the MacLink 
Plus software on the IBM or compatible microcomputer. 
Then start MacLink Plus and use the main menu to set up 
MacLink Plus for the IBM hardware you are using for the 
file transfer. Then select Go Online to Connect with 
Macintosh from the main menu by typing an "0." 

Next set up MacLink on the Mac. Start MacLink Plus and 
click on the Set Mode and Set Communications buttons to 
set up MacLink for the Mac 

IBM TO MAC TRANSFERS 

If you use MacLink Plus to tran1Jfer a WordPerfect 4.2 
document to the Mac, you do not have to do anything 
extra to the document in order to be able to open it in 
tiWordPerfect. When you try to open the transferred 
document tiWordPerfect will ask you if the document is in 
text or WordPerfect 4.2 format. If you select WordPerfect 
4.2, your document will open properly. 

However, if you use Apple File Exchange to transfer the 
same document to your Mac, you may need to change the 
document's Creator and Type before you can open it. To 
make these changes, select tiWordPerfect's File Manage
ment command and click on the All Files button in the 
resulting dialog box. Once you do this, the transferred file 
should show up in the dialog box's list of files. Select the 
transferred file and click on the File/Folder Info button. A 
new dialog box will appear that will let you specify the 
Creator and Type of the document. Change the Creator 
to SSIW and the Type to WPPC, making sure to use all 
capital letters. Now tiWordPerfect will recognize the 

document and let you 
hardware you're using for 
the file transfer; your screen 
will look something like 
Figure 2. Then click on the 
Set Translators button to 
bring up a new window. 

Figure 1: Apple File Exchange 
open it directly. 

Use this new window to 
select two things: the 
direction for the transfer and 
the type of translator to be 
used. Select Binary as the 
type of translator; binary 
means the file will be 
transferred without any 
conversion. 

Click on the Select Files 
button (shown in Figure 2) 
to bring up the next win
dow. Click on this 
window's Connect button 
to establish a connection 
with the IBM or compat
ible microcomputer 
running MacLink Plus. 
Then use the dialog box to 
display the contents of the 
Mac disk and the DOS 
disk. Finally, select the 
document you want to 
transfer, as we did with 
"second test," and click on 
the large Convert & 
Transfer button. 

j File Edit Mac to MS-DOS MS-DOS to Mac 
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Mac WordPerfect version 
l.O.l was supposed to 
have eliminated changing 
the Creator and Type of a 
transferred document 
before opening it. When
ever we used MacLink 
Plus we did not need to 
change them. However, 
in some Apple File 
Exchange tests we needed 
to change the Creator and 
Type, in some tests we did 
not. When we called 
WordPerfect, they said 
they will soon release a 
new version of Word
Perfect for the Mac. This 
version may fix this 
Creator/Type inconsis
tency. At any rate, this 
new version will be sent 
free of charge to all 
registered WordPerfect 
owners. 

The first document we 
transferred from 
WordPerfect 4.2 to 
tiWordPerfect was a 
three-page report. The 
table in Figure 3 shows 
the features of the original 
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IBM document and what happened to those features after 
the document was transferred. 

Cautions 
Whenever transferring documents between different 
applications or versions, you may need to make sure the 
default settings in each application are the same. If they 
are not the same, the transferred document may look 
different simply because the default settings are different, 
not because a given feature failed to transfer properly. For 
example, if the left and right margin justification in 
WordPerfect 4.2 is set to default to "on," when you create 
a document in version 4.2 using this default justification, 
no justification code is embedded in your document. In 
WordPerfect 4.2, word processing codes are embedded in 
documents only if you change a default setting. Therefore, 
when the IBM document is transferred and opened in 
tiWordPerfect, the Mac version's default margin justifica
tion will be used to format the document. If the default 
margin justification in tiWordPerfect is not full justifica
tion, your initial reaction may be to think that the IBM 
document didn't transfer properly. 

Figure 3: IBM to Mac 

WordPerfect 4.2 -+ tiWordPerfect 

Left and Right Margins ................... Left and Right Margins 
at 10 and 74 at 1" and 7.5" 

Header A on Every Page ................. Header A on Every Page 
Page Number in Top Right .............. Same 

Comer of Every Page 
Left Tab at 15 ............................... Left Tab at 1.5" 
Center Tab at 50 ........................... Center Tab at 5" 
Right Tab at 75 .............................. Right Tab at 7" 
Table with Three Columns ............... Table with Three Columns 

(used Left tabs (used Left tabs 
at 20, 30, and 40) at 2", 3", and 4") 

Change to Different Font Size ......... Ignored * 
Change to Italic Font ...................... Ignored * 
Bold Text ....................................... Same 
Underlined Text .............................. Same 
Left Margin Justified ....................... Same 

(Justification Off) 
Left and Right Margin Justified ........ Same 

(Justification On) 
Rush Right .................................... Same 
Left and Right Margin ..................... Left and Right Margin 

at 25 and 45 at 2.5" and 4.5" 
Left-Right Indent ............................ Left-Right Indent 

to 20 and 71 to 2" and 7" 
Hard Page Break ............................ Same 
Four Footnotes .............................. Same 

* Ignored but "non-Mac code" inserted. 

These codes do not appear to affect the document in any 
way. If you want to delete these codes, you must do it 
manually; there is no way to search for these codes. 

Printing 
We printed both the IBM and Mac documents on an 
Apple LaserWriter. The biggest difference between the 
two was where text was located on the page. For example, 
our fully justified paragraph in the original IBM document 
had different margins than the transferred document. The 
table below shows those differences. 

WordPerfect Version 
IBM 
Mac 

Left Margin 
7 /8-inch 
l-inch 

Right Margin 
2 l/4-inch 
l-inch 

WordPerfect 4.2 and tiWordPerfect handle proportional 
fonts entirely differently. Therefore, if you use propor
tional fonts, such as Times and Helvetica, and want the 
Mac and IBM document to look the same when the 
documents are printed on the same printer, be prepared to 
make some margin adjustments. (When you print the 
same documents on different types of printers, you proba
bly still have to adjust the document's margins.) 

Figure 4: Mac to IBM 

tiWordPerfect -+ WordPerfect 4.2 

Left and Right Margins .............. Left and Right Margins 
at 1" and 7 .5" at 10 and 75 

Header A on Every Page ............ Transferred * * 
Page Number in Upper Right ...... Same 

Comer of Every Page 
Left Tab at 1.5" ........................ Left Tab at 15 
Center Tab at 4.5" .................... Center Tab at 45 
Right Tab at 6.75" .................... Right Tab at 67 
Table with Three Columns ......... Table with Three Columns 

(used Left tabs at (used Left tabs at 
2.75", 4.25", and 6.25") 27, 41, and 61) 

Change to Different Font Size .... Ignored 
Change to Different Font ........... Ignored 
Bold Text ................................. Same 
Underlined Text ........................ Same 
Left Margin Justified ................. Same 

(Justification Off) 
Left and Right Margin Justified .. Same 

(Justification On) 
Rush Right ............................... Same 
Left and Right Margin ................ Left and Right Margin 

at 2" and 6.5" at 20 and 65 
Left-Right Indent ....................... Left-Right Indent 

to 2" and 6.5" to 20 and 66 
Hard Page Break ...................... Same 
Six Footnotes ........................... Transferred * * 
Italic Text ................. : ............... Ignored 
Graphic Image .......................... Blank Line 

on a Separate Line 
Graphic Image Embedded ......... Ignored 

Within a Paragraph 

* * Transferred but had to be corrected. 
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MAC TO IBM TRANSFERS 

In order to transfer an tiWordPerfect document to 
WordPerfect 4.2, you must first save the tiWordPerfect 
document in WordPerfect 4.2 format. Both the Save and 
Save As dialog boxes in tiWordPerfect let you select the 
type of file format you want to save the document in; click 
on the IBM WP 4.2 button. 

Regardless of whether you use Apple File Exchange or 
MacLink Plus to transfer a Mac document to an IBM-com
patible, you do not have to do anything to the document 
in order to open it in WordPerfect 4.2. The first docu
ment we transferred from tiWordPerfect to WordPerfect 
4.2 was a three-page report. The table shown in Figure 4 
shows the features of the originaltiWordPerfect document 
and what happened to those features after the document 
was transferred directly to WordPerfect 4.2. 

At first it appeared that footnotes did not transfer properly 
when going from tiWordPerfect to WordPerfect 4.2. One 
problem with the footnotes in the IBM document was that 
a Soft Page code was inserted after each footnote; there
fore, no matter how little text was on the page, when a 
footnote number appeared on the page, WordPerfect 
moved the next lines to a new page. Another problem was 
that footnote text did not print on the page that had the 
footnote number. 

We fixed both problems by using a WordPerfect 4.2 
procedure that resets the margins for footnotes after the 
margins in a document have been changed: we selected 
WordPerfect 4.2's Spell option and chose Count to get a 
word count for the document. (WordPerfect said that 
these problems with transferring footnotes may not be 
fixed in the new Mac version.) Using the Speller to get a 
word count for the document also corrected another minor 
problem with the header. The procedure reset the margin 
for the header to match the margins in the document. 

MAC ~ IBM MAIL MERGE 

We also transferred simple mail merge documents without 
any problems. We created Primary and Secondary docu
ments on both the Mac and the IBM. Both Secondary 
documents contained names and addresses that were 
divided into three fields. Both Primary documents merged 
the name and address fields at the top of a simple letter. 

CoNCLUSION 

Transferring documents between the Mac and IBM
compatible versions ofWordPerfect works fairly well. Of 
course, transferring documents between two applications, 
even if both applications are made by the same company, 
usually involves adjusting the documents after they've been 
transferred. With the documents we transferred, most of 
these adjustments were relatively minor. 

{ ... NEWS CONTINUED FR.OM .......... PAGE 45 
the latest AppleShare 2.0.1 upgrade for free instead of 
paying $50 for it. (To continue to receive free upgrades, 
departments must formalize their site license participation; 
that is, send us a Journal Voucher for the AppleShare 
renewal fee. The $50 renewal fee is due July 1, 1989.) 

To get the free upgrade, site license participants must do 
two things: sign the Rrgistered Authorized User Certificate 
required of all site license participants and bring their 
master disk to room 118 in the Shepherd Labs building. 
We will give you disks with the version 2.0.1 upgrade on it. 
(For more information about the 2.0.1 upgrade, read the 
AppleShare announcements in our December 1988 and 
January 1989 newsletters.) 

Manuals 
AppleShare manuals must be purchased separately; cur
rently we do not have their price. We expect that the 
manuals will be available soon in the Reference section of 
the Minnesota Book Center in Williamson Hall. 

• NEW MACINTOSH SE/30 
Apple recently announced a new Macintosh: the Mac SE/ 
30. The Mac SE/30 looks deceiving. Although this new 
Mac looks like the SE, it has the same 32-bit, 16 MHz 
68030 microprocessor as the Macintosh Ilx (thus the name 
SE/30). The back of the Mac SE/30 looks familiar; it has 
the same seven built-in connectors and interfaces, such as 
SCSI and serial ports, as the Mac SE. Since the SE/30 is 
designed to be compatible with the rest of the Macintosh 
line, we expect it to run the same software. 

The SE/30 uses the Apple 1.4 megabyte FDHD (floppy 
disk high density) that was announced when the Mac Ilx 
was released. The FDHD is capable of reading and writing 
to 400K, 800K, and 1.4MB Mac disks as well as 720K and 
1.44MB DOS compatible disks. For some people this 
capability will be very useful; it means they can use this 
FDHD disk and the Apple File Exchange utility to transfer 
plain text files from a 3.5-inch DOS (or a ProDos) disk to 
their favorite Mac word processing software and vice-versa. 

You can expand the SE/30 by using its one 32-bit slot for 
one card, such as an Ethernet or video card. This 030 
Direct Slot is incompatible with SE-Bus expansion cards or 
Mac II expansion cards. You can use Apple's standard 
Memory Expansion Kits to upgrade the RAM on the SE/ 
30 configurations to 8MB; to upgrade to 8MB you need 
four 2-megabyte kits. Since the SE/30 has its 256K of 
ROM on a SIMM (Single In-line Memory Module), 
putting in new ROMs will be easier. 

The SE/30 includes the same Apple Sound Chip that is in 
the Mac II and Mac Ilx. This chip provides four-voice, 
wave-table synthesis, and a stereo sample generator; it can I 
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mix left and right channels for the internal speaker or 
provide full stereo sound output through a stereo phone 
plug. 

How fast is the SE/30? Apple claims it has four times the 
computational speed of the Mac SE; and since the SE/30 
includes a 68882 floating-point co-processor (operating at 
16 MHz) Apple says it is up to 100 times faster than the 
Mac SE for complex math functions. Based on the 
processor and clock speed, we expect the Mac SE/30 to be 
about the same speed as the Mac IIx. 

Like the other Macintoshes sold at the Electronics Desk, 
the Mac SE/30s come with a mouse, standard keyboard, 
and the following software: Apple File Exchange, Hyper
Card, MacPaint, and your choice of either WriteNow or 
Microsoft Word. Based on information provided by Apple, 
we expect the SE/30s to be available by late March. You 
can place your order for these SE/30 configurations: 

Model 

M5392 
M5390 

M5361 

Macintosh SE/30 Discount Price* 

1MB RAM and one floppy disk $ 2790 
1MB RAM, one floppy, and one 
internal 40MB SCSI hard disk 3085 
4MB RAM, one floppy, one internal 
80MB SCSI hard disk, and Mathematica 4250 

* To get the Apple enhanced keyboard (M0115) instead of 
the standard keyboard, add $60 to the price. 

We hope to have a Mac SE/30 available for your inspec
tion in the Microcomputer HelpLine soon. 

e UPGRADE FoR PC-DOS 4.0 
We have PC-DOS 4.0 Corrective Service disks, otherwise 
known as an upgrade, update, or patch for PC-DOS 4.0. 
This free upgrade will be especially useful to PS/2 Model 
50Z owners who want to use EMS (Expanded Memory 
Specification) with PC-DOS 4.0. To get the free upgrade 
bring two 3.5-inch, 720K or three 5.25-inch, 360K format
ted disks to the Microcomputer HelpLine. The Update 
procedure we discuss below will not work if you try to copy 
the files onto fewer disks. 

This upgrade works only with PC-DOS 4.0. If you don't 
already have PC-DOS 4.0 installed on your working disk 
and you try to install this upgrade, you'll get the message: 
Incorrect DOS version. To find out which version of DOS 
you have, use the VER command. 

IBM has included an Update procedure that automatically 
installs the upgrade onto your hard disk. (If you have only 
a floppy drive system, you can use the· Replace command to 
update your working disks.) To use IBM's Update 
procedure, put the disk labeled "Vol. 1" into disk drive A. 
What you type depends on which disks you're using. 

If you're using the 3.5-inch disks, type 

a :update 2 

If you're using the 5.25-inch disks, type 

a:update 3 

The Update procedure will prompt you to enter informa
tion and insert new disks when it needs them; this proce
dure will also copy all necessary files to your working disk. 
When Update asks you a question, it even supplies an 
answer. This answer assumes you have a typical setup. If 
you do have a typical setup, just press the return key to 
confirm the answer Update has already supplied. If you 
want to respond with a different answer, type in the new 
answer. For example, you may have reset your default 
keyboard setting to be French (FR) rather than American 
English (US). Here are sample questions: 

Update Question 

Enter your keyboard code 

Enter the drive which contains 
files to be replaced 

Do you want to replace the DOS 

files in all directories (YIN) 

Answer 

us 

C: 

y 

If you have a PS/2 Model 30 with an 8512 monitor and 
you have been unable to select Help from the Change 
Colors program, this upgrade can also help you. Although 
the Update procedure automatically copies the new help 
file (SHELL.HLP), it does not copy the new SHELL 
menu (SHELL.MEU) file to your working disk. You must 
move the menu file yourself; the SHELL.MEU file is on 
the Volume 1 disk. If your working disk is drive C (called 
c : \ below) and you already have a file on it named 
SHELL.MEU, you can use the following command: 

replace a: \document \shell_meu c: \ lu Is 

(Since the I u parameter replaces older files on the target 
disk drive C with new files, if drive C does not have a file 

' ' named SHELL.MEU, DOS reports No files replaced. For 
more information about the Replace command, read your 
DOS manual.) If you previously made changes to the 
SHELL Main Group menu, you must re-enter those 
changes once the updated SHELL.MEU file has been 
copied to your hard disk. 

Determining whether or not you have the new version of 
PC-DOS is not as straightforward as installing the Up
grade. You cannot tell if the upgrade is already installed on 
your machine by using the VER command because the 
version will not change. However, you can tell whether or 
not you've got the new files by checking their sizes .. The 
table below lists the files packaged on the Update d1sks and 
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gives each file's size and date. (The Volume 1 disk also 
contains AUTOEXEC.BAT and CONFIG.SYS files; 
neither file is automatically copied onto your working 
disk.) 

File: PC-DOS 4.0 Upgrade Size Date 

APPEND.EXE 11186 8-03-88 
COUNTRY.SYS 12838 6-17-88 
DISPLAY.SYS 15741 6-17-88 

EGA850.CPI 9965 8-03-88 
IFSFUNC.EXE 21653 8-03-88 
KEYB.COM 14759 6--17-88 

KEYBOARD.SYS 23360 8-03-88 
LCD850.CPI 2178 8-03-88 
MODE. COM 23056 8-03-88 

PRINT.COM 14024 8-03-88 
README 3056 8-03-88 
REPLACE.EXE 17199 6-17-88 
SELECT.DAT 22453 8-03-88 

SELECT.EXE 99545 8-03-88 
SELECT.PRT 1594 8-03-88 
SHARE.EXE 10301 8-03-88 

SHELL. HLP 65667 8-03-88 
SHELL.MEU 4588 8-03-88 
SHELLC.EXE 154377 8-03-88 

SYS.COM 11472 6-17-88 
UPDATE.COM 7821 8-03-88 
XMA2EMS.SYS 29249 8-03-88 

Since the Update procedure only copies essential files, some 
files, such as SELECT.PRT, may not be copied onto your 
working disk. If you have a typical setup you won't need 
many of the files that come with the upgrade. However, if 
your hardware or software requires these other PC-DOS 
4.0 files, you can copy these files from the Update disks to 
your working disk. 

For the curious, the abstracts of the problems fixed by this 
patch, which are listed in the Update's README file, are 
reprinted below. 

Component Abstract 

APPEND 
IBMBIO 
IBM DOS 
IBM DOS 

MODE 
MODE 
MODE 
PRINT 

SELECT 
SELECT 
SELECT 
SELECT 

APPEND /PATH:OFF not working properly 
INT 2FH forINT 67H causes hang 
BUFFERS=XX /X problem (BUFFERS to XMA) 
Problem copying large files across net 

MODE allows 19200 rate on PS/2 mod 25,30 
MODE not handling trans. correctly 
MODE overwrites user's application 
First time PRINT non-exist file msg 

Listing of printers should be recorded 
SELECT correct defaults for keyboards 
SELECT /SHELL translated too big for 256K 
Using CTRL/BREAK with SHELL can hang 

SHELL 
SHELLC 
SHELLC 
SHELLC 
SHELLC 
SHELLC 
SHELLC 
SHELLC 

XMA2EMS 
XMA2EMS 
XMA2EMS 

PS/2 mod 30 with 8512 error color change 
Pull down menu in files gives wrong help 
SHELL does not give error for I or\ 
SHELL HELP index entries not alphabetic 
SHELL not handling trans. correctly 
SHELL place hdwr cursor with selection 
SHELL will not run after run Comp. BASIC 
SHIFT +F9= overlays F10= 

Hangs with Token Ring NET CARD in slot 0 
PS/2 mod 50Z cannot use DOS 4.0 EMS 
Unpredictable results using DMA to EMS 

• NEw Puouc MicRo LAos 
There are two new microcomputer labs: 121 Elliott and 
135 Classroom Office Building. Current students, faculty, 
and staff can use these and other public (public to the Uni
versity of Minnesota community) microcomputer labs. To 
use these labs you must buy a Microcomputer Access Card 
for $30/quarter. The back of this card lists most of these 
public labs; however, the card may not yet list the new labs. 

For more information about the University's microcom
puter labs, read our October 1988 Public Microcomputer 
Labs and Special Services article. Phone numbers for the 
labs ACSS (Academic Computing Services and Systems) 
manages are listed in the 1988-89 Student-Staff Directory. 

Elliott Hall 
The public microcomputer lab in 121 Elliott Hall opened 
at the beginning of Winter Quarter 1989; the lab's phone 
number is 624-0866. (This location formerly housed an 
ACSS-net terminal lab.) The new microcomputer facility 
still has 9 ACSS-net terminals and now includes 5 Macin
tosh Pluses and 20 IBM PS/2s; the Elliott Hall lab has a 
facility for DOS users with 360K disks to transfer informa
tion to the PS/2's 3.5-inch disk drives. 

IBM-compatible peripherals include two ProPrinters, two 
Hewlett-Packard DeskJet printers, and an IBM laser 
printer. IBM-compatible software includes DOS 3.3, 
Borland Turbo Pascal 5.0, Borland Turbo C 2.0, Microsoft 
Word 4.0, WordPerfect 5.0, and Aldus PageMaker. 

Macintosh peripherals include a Mac SE file server, an 
Image Writer printer, a LaserWriter liNT, and an Apple 
scanner. Macintosh software includes MacWrite, 
MacDraw, MacPaint, Microsoft Word, Quick Basic, and 
HyperCard. Additional Macintosh hardware should be 
installed by the end of Winter quarter. 

Classroom Office Building 
As of this newsletter's deadline, a new ACSS microcom
puter lab is scheduled to open in late January in Classroom 
Office Building 135 on the St. Paul Campus. The lab's 
phone number will be 624-9226. This lab is being set up 
as two separate computer classrooms. When not scheduled I 



for classes, these classrooms will be available for drop-in 
use by Microcomputer Access Card holders. Jamil Jabr, the 
supervisor of this COB facility, will have an office there. 
This facility is in the former room 125 complex; the 
complex included ACSS-net terminals and a mainframe 
lineprinter. A portion of the ACSS-net facilities has been 
moved to B40 Central Library. 

The new 135 COB facility will include approximately 25 
Macintosh Pluses and 25 IBM PS/2s; COB has a way for 
DOS users with 360K disks to transfer information to the 
PS/2's 3.5-inch disk drives. Laser printing services will be 
available along with dot-matrix printers. 

Printing 
To use laser printers in any public microcomputer lab, you 
must also buy a Printer Access card. The printer card costs 
$1 and does not have an expiration date; laser printing 
costs are 10¢ per page. 

New Labs' Hours 
Here are the hours for the new Elliott Hall and Classroom 
Office Building labs: 

Sunday 
Monday-Thursday 
Friday 
Saturday 

4 pm to 10 pm 
8 am to 10 pm 

8 am to 6 pm 
10 am to 6 pm 

• MATHEMATICA MANUALS 

In our January 1989 newsletter we reviewed Mathematica, 
software for the Macintosh. After we went to press with 
our review we learned that Stephen Wolfram's book, 
Mathematica- A System for Doing Mathematics by Com
puter, is not bundled with the discounted version. You 
can, of course, still get Wolfram's book. Your options are 
described below. We're sorry for any inconvenience this 
change may have caused you. 

If you purchase the Mathematica software without 
Wolfram)s manual, your cost is $175, as stated in our 
January review. You can also purchase Mathematica 
bundled with Wolfram's manual; in that case your cost is 
$197. Wolfram's book is also available separately for 
$35.25 from the Reference section of the Minnesota 
Bookstores. 

The special Mathematica price for those who already have 
memory chips on order from the Minnesota Bookstores for 
the Mac II or Mac SE, is still available; that price is $25 for 
Mathematica and $22 for the manual. 

• VENTURA PUBLISHER USERS GROUP 

If you are interested in joining a users group dedicated to 
Ventura Publisher desktop publishing, call Cheryl Edwards 

at 935-3464. Unfortunately we got the group's notice too 
late to get their January meeting notice to you. But there 
should be a February 28th meeting since this group plans 
to meet the fourth Tuesday of every month to discuss issues 
relevant to Ventura use. Call Ms. Edwards for more 
information. 

Training Resources 

The Microcomputer Group owns training 
packages for many popular software programs. 
These training packages are available to Univer
sity of Minnesota departments and current 

employees and students. There is no fee for using these 
packages, and you may check them out for 48 hours. 
However, before you can check them out, you must sign a 
Usage Agreement and leave your University of Minnesota 
ID with us. We will return your ID when you return the 
training materials. To use these materials you must supply 
your own equipment, such as computer and cassette player. 
To reserve or check out materials, talk to Margaret 
Stefansky in room 118 Shepherd Labs at phone 625-1300. 

Generally the PC/MS-DOS (IBM-compatible) disks are 
available on 5.25-inch 360K and 3.5-inch 720Kdisks; the 
Macintosh disks are 800K. The Mac packages listed below 
are marked with anti; IBM packages are marked with a •:• . 

Our January 1989 article on training packages had one 
error and one omission. The omission was Module 7 in 
the Excel training series. Module 7's full description is 
given below. The error was in HyperCard's Module 4 
description. We inadvertently stated that you need Hyper
Card version 3.0 to use this module; this module will work 
with any version of HyperCard, including the current 1.2.1 
version. 

ti Excel: Module 7-Advanced Spreadsheets audio 
training from Personal Training Systems' EXCELLERATE 
series. Training Objectives: This package, for the skilled 
Excel user, shows you how to create custom formats and 
control precision, create look-up tables, and transpose 
areas. System Requirements: At least a 512K Mac and your 
own copy of Excel. 

We recently added the following material to our library. 

•:• Microsoft Word version 4.0: Mastering Word 
Processing is a VHS video package from Anderson Soft
Teach. Each lesson runs 10-25 minutes. Training 
Objectives: Master over 30 Wor~ skills. Lesson 1 co~e~s 
creating documents; lesson 2 gutdes you through reVIsmg 
documents; lesson 3 covers formatting and printing; lesson 
4 shows you how to use the speller and Thesaurus; and 
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lesson 5 shows you how to work with Glossaries. System 
Requirements: IBM-type personal computer and your own 
copy of Word. 

Connections: Telnet 

As the number ofMacintoshes and IBM-
~ compatibles connected to the campus m internet continues to grow, the NCSA 

NCSA Telnet Telnet application is becoming a very 
popular way to connect and log in to a 

mainframe computer on the campus internet. Telnet is 
popular for more reasons than its price (it's free) and its 
speed (communication speeds are much faster than with a 
dial-up connection). People use Telnet because good 
VT100 and Tektronix terminal emulation is available, ftp 
(file transfer protocol) is supported, and because it allows 
Macintosh users to have multiple terminal sessions running 
in separate windows; for example, you could be logged 
into the ACSS VAX in one window while being logged 
onto the ACSS Encore in another window. 

While many people use Telnet's terminal emulation 
facilities, the ftp capability is not as widely utilized. In this 
article we'll show you how to use ftp and how to protect 
yourself from some unexpected ftp side-effects. 

FTP: FILE TRANSFER PROGRAM 

Ftp is a file transfer program that allows you to transfer 
files quickly and reliably between two computers on a 
network. Many mainframes have ftp capabilities. If you 
are running NCSA Telnet on a Macintosh, you will find 
that ftp is built right in. This allows you to transfer files 
easily between a Mac and other computers on the network. 

Suppose you are using Telnet on your Mac and are logged 
into the ACSS Encore (UX). Further, suppose you have a 
plain text file called "macFile" on your Mac hard disk, and 
another text file called "encoreFile" on the Encore main
frame. You want to transfer macFile to the Encore and 
bring encoreFile down to your Macintosh hard disk. (Plain 
text files can be used by most any machine.) 

To do this choose the Mac Telnet Network menu's Send 
FTP Command option. This will result in a string such as: 

ftp -n 128.101.201.108 

being sent to the Encore. (The number 128.101.201.108 
is the current network address of your Mac.) This string 
informs the ftp program on the Encore that it is to prepare 
to transfer some files from (or to) your Macintosh. A few 
lines will be displayed after the ftp program on the other 

computer succeeds in establishing contact with your 
Macintosh. Here are some sample Encore lines: 

Connected to 128.101.201.108. 
220 Macintosh Resident FTP server, ready 
ftp> 

At this point, the ftp program on the Encore will act in 
concert with the ftp facility on your Mac. You type 
commands to the Encore and it enlists the help of your 
Mac. To send the file we've called encoreFile to your Mac, 
type the put command as shown below. 

put encoreFile 

and the file will be transferred to your Mac. Here are more 
sample lines from our ftp session: 

ftp> put encoreFile 
200 This space intentionally left blank < > 
150 Opening connection 
226 Transfer complete 
1381 bytes sent in 0.29 seconds ( 4.5 Kbytes/s ) 
ftp> 

To transfer the file we've called macFile from your Mac to 
the mainframe, use the get command. Another sample 
session is shown below. 

ftp> get macFile 
200 This space intentionally left blank < > 
150 Opening connection 
226 Transfer complete 
1381 bytes received in 0.29 seconds (4.5 Kbytes/s) 

Initially many people find it difficult to keep the put and 
get commands straight. Remember, what you type on your 
Macintosh is going to the ftp program on the remote 
computer. From the point of view of Encore, getting a file 
means a Mac-to-Encore transfer ("get a file from some
place and bring it here") and putting a file means an 
Encore-to-Mac transfer ("put this file I have here onto 
some other machine"). 

PROTECT YOURSELF 

The built-in ftp capability ofNCSA Telnet for the Mac 
unfortunately introduces a possible privacy or security 
breach that is not immediately apparent: while you are 
using Telnet, it is possible for someone else who is also 
logged onto the mainframe to get files from and put files 
onto your Mac unless you take explicit steps to prevent this. 
This breach is possible because once a knowledgeable 
person finds out the current IP address (network address) 
of your Macintosh (in this example 128.101.201.108), 
they could type 

ftp -n 128.101.201.108 



and connect to your Mac. To prevent such unauthorized 
access, you should set your copy ofNCSA Telnet up to 
require a password before anyone can initiate ftp to your 
Macintosh. Password protection is a two-step process. 

Step One 
Create a file with your choice of password. To do this, 
launch the application Telpasthat comes with Mac Telnet. 

Click on the New User button. Type in your user name, 
for example harpo. Click on the OK button. Your user 
name will appear in a scroll-box. Select it (click on it). 
The Set password button will become active (it will change 
from a grey, inactive state to a normal, active button). 
Click on it and type your password into the box that 
appears. The characters you type will not be displayed, but 
will appear as little ll symbols. 

Click the OK button and quit the application. You will be 
asked if you want to save the password file you just created. 
You do want to save it, so give it a name (such as pass
word) and save it. Put this file and the file called config.tel 
that came with NCSA Telnet in the same folder as the 
Telnet application or in your Mac's System Folder. 

Step Two 
Open the config.tel file. You will need to open it from 
inside a word processor; you cannot just double-click on it. 
Change the following line: 

#passfile="HD20:Telnet:ftppass" #name of 
file to find FTP passwords in 

Since we chose password as our password file's name here is 
what our edited line looks like (note that there is no# at 
the start of the edited line): 

passfile="password" # name of file to find 
FTP passwords in 

Save the new, edited file as a text only or ASCII file. 
(Usually you will find these options in the File menu's Save 
As command.) 

When you next want to use ftp to transfer files to/from 
your Mac, type your user name and password before you 
type get, or put, or another ftp command. The text you 
type is shown in bold in the sample below (in our sample 
our user name is harpo). You type your password after this 
request: 

Password: 

You don't see anything after Password because the pass
word characters are not be shown on the screen as you type 
them. 

ftp> user harpo 
331 Password required 
Password: 
230 User logged in 
ftp> 

Book Center Notes 

These offers are made to University departments, 
employees, and students; the regular rules of eligibil
ity apply. If you have questions about availability, 
phone the Electronics Desk at 625-6681. 

• MACINTOSH CHANGES 

Apple made changes, and we made a change. Apple re
duced prices on some of their products, including Macin
toshes that come bundled with more than a megabyte of 
RAM. We're bundling Mathematica with the Macs that 
have more than one megabyte ofRAM. Here are the new 
discount prices. 

Model Apple Product Price 
Old New 

M0334 Personal Modem (300/1200 baud) 
and cable for Mac Plus/SE/11 $ 275 $ 220 

M5355* Mac SE with 2MB RAM 
and 40MB hard disk $3200 $2870 

These Mac /Is come with 4MB RAM but no monitor or video card 
M5410* Mac II with 40MB hard disk $ 4975 $ 4690 
M5820* Mac llx with no hard disk 4800 4450 
M5830* Mac llx with 80MB hard disk 5750 5020 

Apple Internal hard disks * * 
M0216 20SC for Mac SE and II 
M0232 40SC for Mac II 
M0233 80SC for Mac II 

$700 
1395 
2235 

* Mathematica is included with these Macintoshes. 

$595 
875 

1225 

* * These internal disks require installation by a Level 1 
technician. Installation fee is included in the price if the 
disk is ordered at the same time as the computer. If 
ordered separately, you must pay for installation. Call 
Engineering Services at 625-1595 for installation costs. 

• MEMORY CHIP MADNESS 

As many computer users are aware, for over a year there has 
been a shortage of memory chips for most microcomputers 
and workstations; this shortage has affected Mac and IBM
compatible users alike. Dealing with memory suppliers is 
now like dealing with commodities brokers: potential 
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buyers receive daily price quotes and availability informa
tion. And the quality of SIMMs (Single.Inline Memory 
Modules) can vary greatly. 

Because of the volatile prices of memory, we stopped 
carrying memory chips except for Apple's 1MB SIMMs. 
While these chips have been available, delivery has been 
very sporadic and slow. In our attempts to satisfy the 
campus demand for memory, we investigated other 
memory sources and tried to negotiate prices. When we 
recently obtained a shipment of SIMMs, we sent a letter to 
people who have outstanding memory orders informing 
them that memory upgrades are now available for $840 for 
a 2 megabyte set. The people with the oldest orders were 
notified first and given these options: 

l. pay the current price and get the memory now; 
2. have us hold your order until the price goes down, at 

which time they would again be notified; or 
3. simply cancel the order. 

Upon receipt of this letter, some people experienced 
"sticker shock" and complained a bit. Although we sympa
thize with your frustrations, we, too, are caught in the 
middle of this situation. 

In an attempt to be fair to all participants in the discount 
program, we've established the following procedure. As 
we are able to obtain chips, we will post their daily "carry
away" price (excluding installation costs) at the Electronics 
Desk and the Microcomputer HelpLine. We will continue 
to send out notifications to those who have placed orders 
and allow them the same three choices listed above. 

A final note: those who receive the letter and chose to buy 
the 2MB memory upgrade for $840 (option 1), can buy 
Mathematica for Macintosh at the reduced price of $25; 
the manual is an additional $22. Those who pick options 2 
or 3 cannot buy Mathematica at the special price. 

• PROPRINTER CLOSEOUT 

While supplies last, you can buy some older model IBM 
dot-matrix ProPrinters at the Electronics Desk: the 9-pin 
ProPrinter XL for $200 and the 24-pin ProPrinter XL24 
for $325. Both ProPrinters print in draft mode at 200/ 
240 characters per second (cps) and come with a standard 
carriage for use with 8.5-inch by 11-inch paper. Either 
printer lets you print on continuous forms or lets you 
manually insert one piece of paper at a time, like on a 
typewriter. In near letter quality mode the ProPrinter XL 
prints at 40 cps. In letter quality mode the ProPrinter 
XL24 prints at 67/80 cps. Both ProPrinters come with a 
90-day warranty but no parallel interface cable. Neither 
printer is available in the Microcomputer HelpLine. 

And Books, Too 

If you cannot find the computer and software 
books you want in the Bookstores' Reference 
section, tell us what books you want to buy. Stop 
in with your suggestions or send specific titles or 

areas of interest to: Maureen O'Brien, 160 Williamson 
Hall, Minnesota Book Center, 231 Pillsbury Drive SE, 
Minneapolis, MN 55455. 

e NEw BooKs 

Here's what is new in the Reference section. 

fl" Microsoft Word 5 Made Easy by P. Hoffinan. This IBM 
and compatible manual sells for $19.95. (Microsoft 
plans to release Word version 5 soon.) 

fl" Lotus Guide to Using Manuscript Release 2 by C. 
Williams for $24.95. 

fl" A Practical Guide to UNIX Systems by So bell for 
$27.75. 

fl" Macintosh WordPerfect Guide by D. Read for $21.95. 

e MicRosoFT WoRD BooKs 

In our January newsletter there was an announcement that 
said you could purchase Learning Microsoft Word sepa
rately in the Reference section. Since our negotiations 
with Microsoft fell through, you cannot buy this book 
separately. Although we cannot make Learning Microsoft 
Word available to those who bought the Academic Edition 
ofWord (which does not include the same documentation 
as the Standard Edition), the Reference section carries 
many other Word books. 

In addition to the Microsoft Word 5 Made Easy book 
mentioned above, you can also buy these Word books: 

Macintosh 
fl" Microsoft Word for the Macintosh Pocket Ref for $5.95. 
fl" Using Microsoft Word: Macintosh Version by Lambert, a 

Que book for $21.95. 
fl" Microsoft Word Made Easy for the Macintosh, version 4 

by Hoffinan for $19.95. (Microsoft plans to release 
Word version 4 soon.) 

IBM-compatible 
fl" Using Microsoft Word: 2nd edition by Chase, a Que 

book for $21.95. 
fl" Instant Access Guide to Microsoft Word by Seiffor 

$14.95. 
fl" Microsoft Word Secrets, Solutions, Shortcuts by Sheldon 

for $21.95. 
fl" Microsoft Word Tips, Tricks, and Traps by Pfaffenberger 

for $19.95. 
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